
PCLinuxOS Magazine Page 1

Volume 163 September, 2020

Prism Project: Everyone Is

In Bed With CIA & NSA

Repo Review: LosslessCut

Victory For Fair Use: The Supreme Court

Reverses The Federal Circuit In Oracle vs Google

Use Your Phone Camera As A Webcam

Short Topix: New Crypto Mining Worm

Targets, Attacks Windows, Linux

GIMP Tutorial: Remove A Background

After Cookies, Ad Tech Wants To Use

Your Email To Track You Everywhere

And More Inside. . .

Volume 172 May, 2021



PCLinuxOS Magazine Page 2

From The Chief Editor's Desk

Screenshot Showcase

Prism Project: Everyone is in bed with the CIA / NSA!

Screenshot Showcase

Short Topix: New Crypto Mining Worm Targets,

Attacks Windows, Linux

Screenshot Showcase

Using gLabels: An Update

Screenshot Showcase

Repo Review: LosslessCut

Screenshot Showcase

PCLinuxOS Recipe Corner:

Instant Pot Hamburger Soup

GIMP Tutorial: Remove A Background

After Cookies, Ad Tech Wants To Use Your Email

To Track You Everywhere

Victory For Fair Use: The Supreme Court Reverses

The Federal Circuit In Oracle vs Google

Use Your Phone Camera As A Webcam

Screenshot Showcase

PCLinuxOS Bonus Recipe Corner:

Dump-and-Go Meatball Lasagna

PCLinuxOS Puzzled Partitions

More Screenshot Showcase

3

4

5

9

10

14

15

17

18

19

20

21

23

26

28

29

30

31

35

The PCLinuxOS name, logo and colors are the trademark of
Texstar.

The PCLinuxOS Magazine is a monthly online publication
containing PCLinuxOS-related materials. It is published
primarily for members of the PCLinuxOS community. The
magazine staff is comprised of volunteers from the
PCLinuxOS community.

Visit us online at http://www.pclosmag.com

This release was made possible by the following volunteers:

Chief Editor: Paul Arnote (parnote)
Assistant Editor: Meemaw
Artwork: ms_meme, Meemaw
Magazine Layout: Paul Arnote, Meemaw, ms_meme
HTML Layout: YouCanToo

Staff:
ms_meme Cg_Boy
Meemaw YouCanToo
Gary L. Ratliff, Sr. Pete Kelly
Daniel Meiß-Wilhelm Smileeb
daiashi Alessandro Ebersol

Contributors:
Ramchu

The PCLinuxOS Magazine is released under the Creative
Commons Attribution-NonCommercial-Share-Alike 3.0

Unported license. Some rights are reserved.
Copyright © 2020.

In This Issue. . .

http://www.pclosmag.com


PCLinuxOS Magazine Page 3

Not everything that has come out of the coronavirus
pandemic has necessarily been negative. Even in
areas where lockdowns and isolation have closed
restaurants, bars, indoor movie theaters, and other
“non-essential” businesses, it has given new life and
a resurgence to other business models that were
well on their way to extinction.

I’m talking about drive-in movie theaters. Originally
started in Camden, NJ in 1933, they exploded in
popularity during the post-WWII years. Then, in the
1950s and 1960s, they peaked at over 4,000 drive-in
theaters in the U.S. alone, and some estimates were
over 5,000 worldwide. Drive-in movies have also
served as a backdrop for scenes in such blockbuster
movies, such as Grease and Twister.

Then came along cable TV and the popularity of
home video, first on VHS tapes, and later on DVD.
Never mind streaming. That hadn’t even been
thought of up until that point. The first two were
enough, coupled with changing lifestyles, to kill off
the vast majority of drive-in theaters.

According to DriveInMovie.com, there are
approximately 330 drive-in theaters remaining in
operation today. The vast majority of those are in the
United States, with Canada having about 40 or so
drive-in theaters left, and Australia with 16
remaining. There are a few scattered about Europe,
Asia and South America. There are even some new
drive-in theaters being planned for, which could
result in the first net gain in drive-in theaters in many,
many years.

With the need to maintain social distancing while
seeking entertainment during the pandemic, drive-in
movie theaters have proven their ability to allow
consumers access to the entertainment choices they
want, from the comfort of their cars. It allows patrons

to maintain the precious social distancing that many
governing bodies swear is necessary to stop the
spread of the coronavirus. As a result, they have
been popping up in scattered European cities last
summer during the height of the pandemic
lockdown. Impromptu drive-in theaters have also
been popping up in such places as Walmart parking
lots, as many seek entertainment while being able to
maintain that social distancing.

I have a special love and attraction to drive-in
theaters. Some of my earliest memories involve the

family piling into the car and heading to the drive-in
theater. There were five drive-in theaters in the city
where we grew up, with the closest one less than a
mile away. As kids, we would play on the playground
before the show and during intermission (between
movies), eat popcorn and candy, and drink Vess
soda pop. At some point, all of us kids would fall
asleep in the backseat of the car, with our next
memories being either our parents carrying us to our
bed, or waking up in our bed, unsure of how we got
there.

Then, I started working at one of the drive-in
theaters in town when I was 13 years and nine
months old. I worked through the summer on what
they called the “day crew.” Our responsibility was to
clean up the drive-in parking lot and restrooms for
the new batch of customers who would show up that
night. After working on the day crew for a couple of
years, I moved to working in the concession stand
during the night. I also was the “marquee guy” who
maintained and changed the weekly-changing
theater marquee at the drive-in theater entrance. I
worked at this job until I was 17 years old.

As you might imagine, the drive-in theater is pivotal
in many of my earliest memories. Working at the
drive-in theaters, there were many memories that
had the drive-in theater as a central theme. But, like
with much of the rest of the population, I drifted
away from the drive-in theater and sought cable and
movie rentals to fill the space in my life once
occupied by the drive-in theater.

Fast-forward to 2021, and I am fortunate enough to
have at least two drive-in theaters remaining in
operation within an hour’s drive of me. So, we
popped up a couple of batches of popcorn (none of
that microwave stuff … it had to rival movie theater
popcorn!), packed some drinks, loaded up the

From The Chief Editor's Desk. . .
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blankets, and headed off to the drive-in theater that’s
located in the city where I live. We arrived in less
than 30 minutes, and we sat in the back of dad’s
pickup truck. The kids laid on their sleeping bags in
the back of the truck with the tailgate down, and
mom and dad sat in camping chairs in the back of
the truck. The kids got to watch the new Tom & Jerry
movie, followed by Goonies, from the back of dad’s
pickup truck. The sound was broadcast over the FM
radio band, played on a couple of portable radios we
had brought along. That was a huge improvement
over the solitary, tinny-sounding, monaural speaker
that we used to hang on the edge of our car
windows in the drive-in theater heydays!

The memories it elicited came flooding back to me.
The sounds. The smells. The atmosphere. The dust.
The same idiots driving through the parking lot after
dark with their lights on. None of it had changed.
And I was excited to share the experience with my
own children, 50-plus years after my parents had
shared that experience with me.

Until next month, I bid you peace, happiness,
serenity, and prosperity! And, if you get the chance,
go catch a movie at a drive-in theater!

##########

This month’s cover, “enhanced” by Meemaw,
celebrates the running of the Kentucky Derby. The
Kentucky Derby is the premiere horse race in the
United States, and kicks off the horse racing season
in the U.S.

Visit.
Contribute.
Build.

The PCLinuxOS
Knowledge Base

It Belongs To YOU!

Screenshot ShowcaseScreenshot Showcase

Posted by brisvegas, on March 31 , 2021 , running Mate.
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by Agent Smith (Alessandro Ebersol)

The article I wrote about not breeding crows, which
came out in the March 2021 issue of PCLinuxOS
Magazine, had very good feedback among readers.
I had several positive messages, where folks said
they enjoyed reading it. One reader, however, asked
me for more, and he asked me for sources as well,
as well as for evidence.

Unfortunately, these subjects have no tangible
evidence, at least not at the present time. Maybe in
20 or 30 years, with the freedom to access
information laws, all the shenanigans will come to
light, but I personally doubt it, since there are things
that have been hidden for more than 50 years.

What we can do is present facts, and then connect
the dots. And at the end of the article, I will show
how connecting the dots works. But for those who
want more of the dirty deeds of our Big Tech
companies, here is Prism Project, which the hero
Edward Snowden revealed, and I bring some
details.

In 2013, Edward Snowden revealed the U.S.
government's largest spying scheme

Edward Snowden, one of the most famous
whistleblowers of our time, has brought to light the
many surveillance programs and other spying
activities of the United States government. This
former intelligence officer revealed top secret
documents to Glenn Greenwald (then working for
The Guardian) and Laura Poitras, a freelance
journalist, in May 2013 at a hotel in Hong Kong.

Hero ortraitor?

Edward Snowden: the whistleblower behind the
NSA surveillance revelations.

The individual responsible for one of the most
significant leaks in US political history is Edward
Snowden, a 29-year-old former technical assistant
(at the time) at the CIA, and at the time, an
employee of defense contractor Booz Allen
Hamilton. Snowden worked at the National Security
Agency (NSA) for four years as an employee of
several outside contractors, including Booz Allen
and Dell.

Snowden will go down in history as one of America's
most important whistleblowers, alongside Daniel
Ellsberg and Chelsea Manning. He is responsible for
handing over material from one of the most secretive
organizations in existence - the NSA.

In a note accompanying the first set of documents
he provided, he wrote: "I understand that I will be
made to suffer for my actions," but "I will be satisfied
if the federation of secret law, unequal pardon, and
irresistible executive powers that govern the world I
love are revealed, even if for a moment."

Snowden has traveled to many places, as after his
revelations he became a highly sought-after
individual by the US authorities. He fled to China,
where he revealed the aforementioned secrets, and
then went to Russia. There were attempts to have
him asylum in Brazil, but he preferred Russia, where
the influence of the American government would not
reach him.

Edward Snowden, today

Now 37, Snowden lives in Moscow, Russia. His
girlfriend from his NSA days, Lindsay Mills, also an
American, joined him in Moscow in 2014 and the two
were married in 2017. She announced in late
October, 2020, that they were expecting a baby boy,
who would have Russian citizenship.

In October 2020 Snowden gained Russian
citizenship and permission to live in Russia
indefinitely. Sen. Rand Paul and Rep. Matt Gaetz, as
well as recently pardoned Roger Stone, all urged
President Trump to grant Snowden clemency. In an
Oval Office interview with The Post in August 2020,
Trump said he was open to allowing the
whistleblower to return from Russia without going to
prison.

Prism Project: Everyone Is In Bed
With CIA & NSA!
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In December 2020, the couple's first child, a baby
boy, was born and announced on Twitter.

Snowden and his family, December, 2020

The Prism Project Revelations

Snowden's greatest revelation was about a program
called PRISM, under which the National Security
Agency (NSA) accesses emails, documents,
photographs, and other sensitive user data stored at
big companies.

Microsoft became the first PRISM partner in 2007
and the NSA began collecting large amounts of data
from its servers. Other companies joined the
program in due course. In 2008, Congress gave the
Justice Department the authority to compel a
reluctant company to "comply" with PRISM
requirements. This means that even companies that
were unwilling to join the program voluntarily had to
do so at the behest of a court order.

PRISM began in 2007 in the wake of the passage of
the Protect America Act under the Bush
administration. The program is operated under the

supervision of the U.S. Foreign Intelligence
Surveillance Court (FISA Court, or FISC), pursuant
to the Foreign Intelligence Surveillance Act (FISA).

The documents indicate that PRISM is "the number
one source of raw intelligence used for NSA
analytical reporting, and accounts for 91% of NSA
Internet traffic acquired under FISA section 702
authority." The leaked information came after the
revelation that the FISA court had ordered a
subsidiary of telecommunications company Verizon
Communications to turn over to NSA records the
tracking of all of its customers' phone calls.

But how does this gigantic tapping of the world's
communications work?

We can identify, from Snowden's statements, several
methods:

• Snowden told The Guardian, in his video interview,
that the NSA could access anyone's email, and
even reach far back in time when necessary,
strongly suggesting that the agency is copying
large amounts of data.

• A slide from the presentation Snowden gave to
The Guardian, says that the NSA gets data

"directly from the servers of these US Service
Providers," suggesting that an agent can somehow
get into the computers of Google, Yahoo, etc., and
use a self-service tool to get data from users.

• The tech companies mentioned in the Prism story
deny that the NSA has direct access to their
networks, and are now lobbying for greater public
disclosure of the data they are asked to provide by
the security agencies.

• The New York Times described a "locked mailbox"
process in which the NSA installs its own servers
in a company's server farm. Upon request, the
target companies move data from their servers to
the "lockbox," giving the NSA quick access.

Now, which of the four situations above is true? Well,
let Ashkan Soltani explain.

Ashkan Soltani is an independent privacy consultant
and consumer advocate and former Federal Trade
Commission investigator. He says it is possible that
all of these statements are correct. Depending on
what data the NSA needs, it employs some or all of
these methods to obtain it.

"It probably varies from company to company, based
on what the company is willing to do," he said. "But
the way I think it works is agents issue a directive to
the company, and someone at the company, or a
contractor on site, or a (computer program) collects
those records and loads them into a box that the
NSA can access."

No technologist who was interviewed by NBC (the
original article for this excerpt) for this story believes
that the NSA simply hoovers up every bit of data
from every technology company. Despite advances
in storage and transmission speeds, that would still
be technically challenging and probably
unnecessary. Why recreate Google when the
agency can simply ask Google for the data it wants?

Prism Project: Everyone Is In Bed With CIA & NSA!
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Early versions of the Prism story claimed that the
tech giants involved voluntarily participated in the
program and had no knowledge of the queries made
by the agents. But most companies said they had
never heard of Prism, and that they do not allow
unfiltered access to data. Both may be true, Soltani
said.

However, the situation may have evolved differently.
According to Bruce Schneer:

"NSA surveillance relies heavily on corporate
capabilities - through cooperation, bribery, threats
and compulsion. Fundamentally, surveillance is the
business model of the Internet. The NSA didn't wake
up one day and said: let's just spy on everyone.
They looked up and said, 'Wow, corporations are
spying on everybody. Let's take our piece of the pie.

As we know Big Tech's either started out aided by
government capital, from these 3-letter agencies or,
being older, have other arrangements. But, personal
data is the currency of exchange.

Microsoft bought a company that went bankrupt?
Threw money out the window? That's ok, the CIA or
the NSA can help its cash flow. Just leave the
backdoors always open for them, and everything is
fine.

Speaking of Microsoft, according to the book "Der
NSA Komplex," published by Der Spiegel in March
2014, PRISM also gained access to Microsoft's
cloud service SkyDrive (now called OneDrive)
starting in March 2013. This was accomplished after
months of cooperation between the FBI and
Microsoft.

The Washington Post reported that in the speaker's
notes accompanying the presentation, it says that
"98% of PRISM's output is based on Yahoo, Google
and Microsoft; we need to make sure we don't
undermine those sources." The Post also says that
"PalTalk, though much smaller, has hosted traffic of

substantial intelligence interest during the Arab
Spring and in the current Syrian civil war."

The program's cost of $20 million per year was
initially interpreted as being the cost of the program
itself, but later The Guardian revealed that the NSA
pays for expenses incurred by cooperating
corporations, so it seems more likely that the $20
million is the total amount paid by the NSA to the
companies involved in the PRISM program.

Connecting the dots...

As I said at the beginning of the article, we wouldn't
have hard evidence for everything that has been
leaked, apart from all the evidence that Edward
Snowden leaked to The Guardian in 2013. But, let's
do some deduction exercises, they can help us get a
broader view of the whole picture.

And, let's travel far into the past.

Drug Trafficking

Does anyone remember drug trafficking in the 60’s
and 70’s?

Those who have a good memory, remember that at
that time, drug trafficking was not a problem, as it
became in the 80’s.

In the 60’s and 70’s, the fashionable drug was
heroin, grown in Afghanistan, and coming from the
Middle East. It was a very expensive drug, and its
consumption was restricted.

But, our good friends at the CIA, who needed funds
to sponsor counterrevolutionaries in Central
America, found a great way to make money: Drugs
(cocaine), coming from Colombia, and trafficked into
the USA, with the CIA as facilitator. Since cocaine
was cheaper than drugs from the middle east, they
flooded the streets of the USA, and were the root of
the Iran/Contras scandal.

All this can be seen in the movie American Made,
with Tom Cruise.

Ironically, these days, with the whole Taliban issue, it
seems that the CIA has quite a bit of control of the
opium and heroin plantations in Afghanistan.

Support, training and sponsorship of dictators
and terrorist agents

Who remembers that Saddam Hussein has been
a CIA asset since the 1950’s?

After a failed attempt on the life of General Qassim,
Saddam Hussein fled to Egypt in 1959. While in
Cairo, Hussein repeatedly visited the U.S. embassy
to meet with CIA agents who approached him to
work together to overthrow the Qassim government
in Iraq. Upon his return to Iraq, Hussein was
installed by the CIA in an apartment in Baghdad
located directly across the street from Qassim's
office in the Ministry of Defense. From his apartment
on al-Rashid Street, Hussein was able to observe
the General's movements and report to the CIA. In
1963, with the help of the CIA, the Ba'athist

Prism Project: Everyone Is In Bed With CIA & NSA!
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movement assassinated President Qassim. The US
is among the first nations to recognize the new
government and immediately starts sending
weapons to the new Ba'ath regime. Remarkably, on
the eve of the Ba'athist coup, the CIA provided the
insurgents with a list of 800 Iraqi communists. All of
them were rounded up and murdered by the
Ba'athists.

And that Osama Bin Laden was also trained and
funded by the CIA?

Former British Foreign Secretary Robin Cook said:

"Bin Laden was, however, the product of a
monumental miscalculation by Western security
agencies. During the 1980s, he was armed by the
CIA and funded by the Saudis to wage jihad against
the Russian occupation of Afghanistan."

Several other authors, journalists and statesmen
have stated that bin Laden was funded, armed and
trained by the CIA to fight the Russians.

The CIA trained the mujahideen in many of the
tactics that Al Qaeda is known for today, such as car
bombs, assassinations, and other acts that would be
considered terrorism today.

Insurrections and coups d'état

The Arab Spring: Made in USA

In Ahmed Bensaada's book Arabesque$:
Investigation into the US Role in the Arab Uprisings,
he reports that the uprisings that swept the East in
the 2010s had at least four unique characteristics in
common:

• None was spontaneous - all required careful and
lengthy planning (+5 years), by the State
Department, the CIA through foundations, George
Soros and the pro-Israel lobby.

• All have focused exclusively on removing reviled
despots without replacing the autocratic power
structure that kept them in power.

• No Arab Spring protest made any reference to the
powerful anti-American sentiment over Palestine
and Iraq.

• All the instigators of the Arab Spring uprisings
were middle-class, well-educated young people
who mysteriously disappeared after 2011.

• And, it is important to note that social media
played a major role in making the Arab Spring
uprisings happen.

The Color Revolts

The color revolutions were CIA-instigated revolutions
that replaced democratically elected pro-Russian
governments with equally autocratic governments
more friendly to US corporate interests:

• Serbia (2000) - Bulldozer Revolution
• Georgia (2002) - Pink Revolution
• Ukraine (2004) - Orange Revolution
• Kyrgyzstan (2005) - Tulip Revolution

Flowchart ofthe color revolts

The Fall of President Roussef

On December 17, 2013, Snowden wrote an open
letter to the Brazilian people offering to help the
Brazilian government investigate allegations of US
spying. Brazil had been in an uproar since Snowden
revealed that the US was spying on President Dilma
Rousseff and employees of Brazil's state-owned oil
company, Petrobras.

Two years later there was the opening of
impeachment proceedings of the president, with
information leaked to the media, of corruption in the
state oil company. The involvement of the president
was never proven in the corruption cases, but the
media campaign has worn down the government so
much that the impeachment was inevitable.

The picture is very clear, those who don't want to
see it can't see it

Now, let's do the deduction exercise I mentioned
before. All these events listed above, follow a
pattern: They are movements, people, governments,
organizations, which are generated, trained,
sponsored, in short, created by North American
three-letter agencies. And, not rarely, these
creations, these agencies, in the best Frankenstein
effect, come back to attack the USA and its people.
The USA (and the world, consequently) are victims
of their (CIA/NSA) own creations. Or, as Tony Stark
(Robert Downey Jr.) said in Iron Man 3: “We create
our own demons”.

The 3-letter organizations were present in the
creation of Big Tech's. Today, Big Tech's have grown
so large that they interfere with the communications,
culture, information, and freedoms of both the
American people and the rest of the world.

Prism Project: Everyone Is In Bed With CIA & NSA!
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The poor victims of the cruel and oppressive
government

If you ask these corporations, they will tell you that
governments are the big villains and that they should
not have access to our data. But what about the
corporations themselves? Why should they have
access to our private data? At the very least, with a
democratic government that you elected (let's be
naive for a moment here) you at least have the
facade of representation. You have some power
here, however minuscule or inconsequential it may
seem these days, to determine that government.
You have a vote. Can you say the same thing about
your favorite transnational internet company? You
don't have a vote there.

As mentioned before, such companies have grown
to the point of permanently banning a person from
social networks and media on the Internet. Gag
orders, issued by corporations, not by a judge, not
by a public authority, but by corporations. This is
totally wrong, when corporations take upon
themselves a power that belongs to the state.

Follow me, and in a future opportunity, I will write
more about our favorite technology companies.

Screenshot ShowcaseScreenshot Showcase

Want To Help?
Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!

You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.

Join us on our Google Group mailing list.

Like Us On Facebook!

The PCLinuxOS Magazine

PCLinuxOS Fan Club

Posted by jp, on April 3, 2021 , running fluxbox.
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by Paul Arnote (parnote)

Dortmund, Germany: Free Software Is The
Standard

According to a blog entry from The Document
Foundation, the council of the German city of
Dortmund has announced that it’s moving to free
and open source software, where possible. What
follows is a translation of the original German blog
post.

The Dortmund Council has declared digitalisation to
be a political leadership task in its Memorandum
2020 to 2025. In the course of this, two central
resolutions for free software were passed on
February 11, 2021, for which the minutes were
published on March 30:

* “Use of open source software where possible.”

* “Software developed by the administration or
commissioned for development is made available to
the general public.”

Open source wherever possible

With this resolution, city policy takes on the shaping
of municipal digital sovereignty and digital
participation. The resolution means a reversal of the
burden of proof in favor of open source software –

and at the expense of
proprietary software. In the
future, the administration
will have to justify why
open source software
cannot be used for every
proprietary software
application. Based on the
report of the Dortmund city
administration on the
investigation of the
potentials of free software
and open standards, open
source software is
understood in the sense of
free software.

Public Money? Public
Code!

So, the Council’s decision
is in line with the concerns of the campaign Public
Money, Public Code. What is financed with public
money should be available to the general public for
use. For software, this is achieved by means of a
corresponding free license. With this resolution, local
politicians ensure that the city of Dortmund not only
draws from the free software community, but also

contributes to it. In this way, inter-communal
synergies can be achieved true to the motto develop
together, use individually.

Support for open standards

Through the Digital Dortmund Charter 2018-2030,
among other things, Open Standards were
established as a requirement for further
digitalisation.

Politically unanimous in favor of Free Software

The resolution for free software is supported by a
broad political base. The motion was passed
unanimously by the City Council of Dortmund. The
digitalisation motion was jointly introduced by the
following parliamentary groups: CDU, SPD, Die
Grünen (Greens) and Die Linke (The Left).

Conclusion

The city of Dortmund has ushered in the political
turning point and begun the exit from the proprietary
era. Now it is important that the city finds the
appropriate means to implement this process
practically, by means of a proprietary exit strategy
and to dissolve existing vendor lock-in. For Do-
FOSS, the decision of the Memorandum 2020 to
2025 is the result of a functioning democratic local
discourse. The practical management work for Free
Software has the necessary political backing to
succeed.

DOWNLOAD
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Ba-Da-Boom-Boom-Boom: Another Google App
Bites The Dust

Another month, another Google service or app bites
the dust. Ba-Da-Boom-Boom-Boom. It has become
so commonplace, that it would be news if a month
went by without Google chopping off one of its many
tentacles that weave through just about everything
we see on the web.

Google is ruthless in cutting off its own tentacles.
Launch a service or app, gain a respectable
following, and then pull the rug out from under those
followers/users. Google will cut off all but its most
successful tentacles. For those that remain,
Google’s goal seems to be to screw around with
them when they are working perfectly and
wonderfully, until they no longer work so perfectly or
wonderfully. This time, it’s Google Shopping that has
been sacrificed at the Google Altar.

The strictly-mobile app will be removed from the
Google Play store by June, 2021. You can install it
from there to see what you have (or haven’t) been

missing. Google assures users that it will continue to
work for at least the next several weeks.

Ba-Da-Boom-Boom-Boom. And another one gone,
and another one gone, another one bites the dust!

New Cryptomining Worm Targets, Attacks
Windows, Linux

According to an article on the Ars Technica site,
there is a new cryptomining worm botnet attacking
vulnerable Windows and Linux devices. Called the
Sysrv botnet, it can spread from vulnerable device to
vulnerable device (read, insecure) without any user
intervention (also known as assistance). Once a
device is infected, the cryptomining portion of the
malware gets busy mining Monero digital currency
for its “owner” … which isn’t the same as the owner
of the infected device.

Initially discovered in December, by March the
designers had combined the worm and cryptominer
into one binary. Vulnerabilities in enterprise level
software and frameworks such as Mongo Express,

XXL-Job, XML-RPC, Saltstack, ThinkPHP, and
Drupal Ajax is how the malware finds its way onto
other vulnerable systems. A Juniper Networks blog
post shines even more light on how the cryptomining
worm works and gains entry. At its current rate, the
worm can mine one XMR (currently ~ $200 U.S.)
every two days.

I do like the way the Ars Technica article concludes.
“The threat from this botnet isn’t just the strain on
computing resources and the non-trivial drain of
electricity. Malware that has the ability to run a
cryptominer can almost certainly also install
ransomware and other malicious wares.” The
previously mentioned Juniper Networks blog post
has details about how system administrators can
determine if the systems they oversee have become
infected.

The Great 2021 Ketchup Catch-Up

It’s amazing how far the reach of COVID-19 is. First,
there were toilet paper shortages. Then can goods,
hand sanitizer, disinfecting wipes, paper towels,
soups, bicycles, and a whole bunch of other
seemingly unrelated stuff have taken their turn
leading the lists of items in short supply.

Short Topix: New Crypto Mining Worm Targets, Attacks Windows, Linux
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Now, it’s the individual serving packets of ketchup.
When everything was shut down, ketchup makers –
like Heinz – switched from packaging individual
serving packets of ketchup to the larger bottles of
ketchup we all have in our homes. And, it made
sense, with most restaurants closed down and
people spending more time at home. More people
were cooking and eating food at home, so they were
consuming the larger bottles of ketchup at an
increased rate, while consuming hardly any of the
individual serving packets.

But now that restaurants are starting to reopen,
there’s a shortage of the individual serving packets
of ketchup. According to an article from NPR, Heinz
(who has about 70 percent of the U.S. market share
among ketchup manufacturers) is planning to
increase production of the individual serving packets
of ketchup by 25 percent. In fact, they estimate that
they will have to produce 12 billion packets to catch
up with the ketchup demand.

A Monkey With Implanted Neuralink Plays Pong
… With His Mind

Is there anything that Elon Musk cannot take from
the realms of science fiction and turn into science
fact? With Tesla, he has given us auto-piloting
electric vehicles. With SpaceX, Musk is transporting
NASA astronauts into space, and making plans to
colonize Mars. And now, with Neuralink, one of his

“other” companies, a monkey with implants in his
brain can play pong. With just his thoughts. And he’s
very, very good at it.

Neuralink’s goal is to allow people (think
quadriplegics) to control devices and computers with
brain implants controlled by brain waves, according
to an article on Inc. Eventually, it could lead to more
efficient means of input than clumsy keyboards,
mice and thumb-tapping on mobile devices for
everyone.

After implanting the devices in the monkey’s brain,
they taught him to play pong with a joystick.
Eventually, Pager (that’s the monkey’s name)
learned to use just his thoughts to control the cursor
in the Pong game. You can see Pager in action by
watching the Neuralink video on YouTube.

Microsoft Goes All In On Speech Recognition

Microsoft entered the speech recognition fight in a
huge way, and in the way that Microsoft usually
does: it buys its way in by buying up successful
companies. The jury will still be out as far as what
the outcome will be, however. Microsoft doesn’t
have a very good track record when it comes to the
companies it takes over remaining successful (Nokia
immediately comes to mind, but there are others).

Microsoft’s latest “purchasing victim” is Nuance. You
probably know them better as the company that has,
for years, produced and sold the speech recognition
software called “Dragon Naturally Speaking.” As
widely reported in the computing press, as well as
by Microsoft itself, Microsoft purchased Nuance for
$19.7 billion (U.S.). That represents a 23 percent
premium over Nuance’s closing stock price on April
9, 2021, purchasing shares at $56 per share.

Nuance is also the company that was behind the
voice recognition backbone for Apple’s iOS
successful Siri speech recognition and AI assistant.

The Nuance Dragon software is in widespread use
in hospitals for physicians to dictate their patient
progress notes, and for radiologists to dictate their
radiology findings. Microsoft hopes to leverage
Dragon to increase its AI and cloud offerings to
medical institutions.

It doesn’t sound like things have changed much with
Microsoft. They behave much like the Borg of Star
Trek notoriety. Perhaps their motto should be “When
you can’t innovate, buy up/assimilate those who do.”
Or, maybe that’s been their business plan all along.
Hmmmm.

Short Topix: New Crypto Mining Worm Targets, Attacks Windows, Linux
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University of Minnesota Banned From
Submitting Linux Patches

Just WHO knowingly introduces security
vulnerabilities disguised as fixes for other problems,
just so they can test the security of open source
software? Why, a team of graduate researchers from
the University of Minnesota. That’s who.

According to an article on Neowin, the researchers
from UMN made a point to introduce vulnerabilities
to the Linux kernel, disguised as “hypocrite
commits,” which are fixes for other issues. They
even published a research paper (PDF on GitHub)
about their exploits. As you might expect, the entire
drama played out on the Linux Kernel Mailing List
(LKML). This message on the LKML pretty much
sums up the main thrust of this issue. As a result,
UMN has been banned from contributing to the
Linux kernel.

The UMN Computer Science department did not
take this news especially well. They posted their
response in the comments section of the article on
Neowin that was linked in the previous paragraph.

Leadership in the University of Minnesota Department of
Computer Science & Engineering learned today about the
details of research being conducted by one of its faculty
members and graduate students into the security of the
Linux Kernel. The research method used raised serious
concerns in the Linux Kernel community and, as of today,
this has resulted in the University being banned from
contributing to the Linux Kernel.

We take this situation extremely seriously. We have
immediately suspended this line of research. We will
investigate the research method and the process by which
this research method was approved, determine
appropriate remedial action, and safeguard against future
issues, if needed. We will report our findings back to the
community as soon as practical.

Sincerely,

Mats Heimdahl, Department Head
Loren Terveen, Associate Department Head

Greg Kroah-Hartman, one of the big wigs keeping
Linux kernel on track, mentioned in another LKML
post that all the patches and commits from the
research group were being undone, and reverted to
their previous state. The research group, which has
seriously damaged its reputation with their
underhanded and ill-thought-out research methods,
have since posted an open apology to the LKML, but
I can find little (if any) response to the apology.

PCLinuxOS Short Topix Roundup

GOOGLE HAS SWITCHED FROM USING
COOKIES to using a new tracking method called
FLoC. FLoC is the acronym for Federated Learning
of Cohorts, and is now used by Google Chrome. It
basically uses your browsing history and your search
history to deliver targeted advertising to you as you
traipse around the web. Google claims that FLoC
affords users increased anonymity. DuckDuckGo,
however, doesn’t agree. In fact, they disagree so
much that they have come out with a Google
Chrome browser extension that, among other things,
blocks the FLoC method of serving up targeted ads.
Betanews has an excellent article about the new
DuckDuckGo Chrome browser extension, as does
MarkTechPost.

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!
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BELIEVE IT OR NOT, THERE ARE POSITIVES
COMING OUT OF THE COVID-19 PANDEMIC.
Thanks to the mass release and success of the
coronavirus mRNA vaccines from Pfizer, Moderna
and AstraZeneca, researchers are now taking a look
at using mRNA vaccines to target HIV and certain
cancers. Early trial results are looking very
promising.

WHEN YOU COLORIZE A BLACK AND WHITE
PHOTO, most of the time you have no problem
telling that it was colorized. That’s because the
process is less than perfect, and doesn’t render
things the same way as nature or our eyes. One of
the problems is lacking to take into account how skin
reacts to light, which tends to change with skin
pigmentation. Skin not only reflects light, but also
absorbs light and is illuminated from within by that
absorbed light. A new colorization technique, called
Time-Travel Rephotography, uses AI to change that,
and to take into account how skin really reacts with
light. Old black and white photographs can make its
subjects look old and harsh, because black and
white film doesn’t soften any of the skin tones or
textures. The adding of color helps to hide some of
the harshness and aging effects. It can take old
black and white photographs and produce strikingly
accurate colorized versions of them.

CHARLES “CHUCK” GESCHKE, who co-founded
Adobe, Inc. with John Warnock, passed away Friday,
April 16, 2021, at the age of 81 years. Geschke was
responsible for helping create Adobe Postscript,
which provided a radical and new way to print text
and images on paper, giving rise to desktop
publishing. Geschke and Warnock initially met while
working at Xerox Palo Alto Research Center. The
two men left Xerox in 1982 to start Adobe. You can
read an obituary for Geschke here and here.

Like Us On Facebook!

The PCLinuxOS Magazine

PCLinuxOS Fan Club

Screenshot ShowcaseScreenshot Showcase

Posted by luikki, on April 1 , 2021 , running KDE.
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by Meemaw

It came to my attention recently that since I wrote my
previous article on gLabels, it’s been nearly 9 years!
While I did mention several features of gLabels, my
favorite label program, I didn’t do an actual tutorial or
even review of the program. However, I did another
one earlier. This one’s the how-to, but it’s been over
9 years since I wrote that.

I recently had to do some labels at work (using my
Windows 10 laptop) and found myself wishing I had
gLabels with me in the town where my meeting was.
It would have been MUCH simpler.

gLabels is my absolute go-to for labels. It is in the
PCLinuxOS repo and has been for as long as I can
remember (it’s been a while since I registered on the
forum in 2006). The current version is 3.4.1. Let me
refresh your memory. I’m sure many of you already
know this, but I’m going to try to cover details
anyway.

When you open the gLabels window, it’s pretty
blank, until you choose the label you want to use.

At this point, the only two tools that will function are
the Create new file and Open file buttons at top
left. Click on Create new file to start a label from
scratch. The first window you’ll get is one which asks
which label style you want. If you have a certain
label style you want, (and it seems to have most all
of the standard Avery numbers saved), you can
choose it from the list.

Just under Select Product you will see 3 tabs:
Recent, Search all and Custom. If you have used
some recently, like I have, they will appear in your
Recent tab. Search all is just what it says, a listing of
all the label styles the program has. It’s organized by
brand, paper size and category (square labels,
round labels, CD/DVD cover labels, etc). If you can’t
find what you need, you can always create your
own, and that will be stored in the Custom tab.

The last label I did was a 2 x 4 label for a manila
envelope for a project at work. They were all alike,
so it was the easiest to do. The steps were as
follows:

* Choose the label - mine were 2 x 4. Clicking on the
2 x 4 label illustration and clicking next, you are then
asked which way you want your label oriented.

Depending on what you are doing you can turn it
either way. (I haven’t seen this feature in Office.)

* Review Selection - The third window will ask you to
review what you chose to verify your choices, then
you can click Apply.

Now you will have a nice window with your label in it,
ready to design (next page, top left).

You’ll notice that most all of the tools work now. The
first row is standard New, Open Save, Print, Cut,

Using gLabels: An Update

https://pclosmag.com/html/Issues/201207/page14.html
https://pclosmag.com/html/Issues/201201/page07.html
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Copy and Paste. The second row is the ones you
need now. From left to right, Select, Move and
Modify - Create text object - Create box/rectangular
object - Create line object - Create ellipse/circle
object - Create image object - Create barcode
object. The next four tools Increase magnification,
Decrease magnification, Restore scale to 100% and
Set scale to fit window. The last tool is the Merge
Properties tool.

Let’s add some text. Click on the Create text object,
then click where you want the text to be. You’ll get a
box with the word Text in it, and a sidebar will appear
at the right of the window with all the editing tools
you need. The tools are arranged in tabs, depending
on what you want to do. The first tab says Text, and
you can type your text there, or directly into the text
box on your label.

The next tab says Style, where you can change font,
font size, bold, italic, font color and whether the font
is centered either way inside the text box. The Size
tab controls the size of the text box. The Position tab
controls the position of the text box in the label. The
Shadow tab is where the text shadow is enabled,
and where you can set the offset, color and opacity
of the shadow. Also, some of the most used text
tools are across the bottom of the window.

Here I have added 2 text boxes, and want the
selected one centered. To do that, right click on the
text box and choose Center > Center Horizontally.

You can add rectangles, circles, lines and images
using the other tools. You can even create a barcode
if you know what you’re doing. I clicked on Style and
changed the Backend setting to QREncode, then
used the web address for this magazine, and got a
QR code for the magazine site.

So, what if you want to make labels with names and
addresses? gLabels is the best/easiest program I
know. You should have a spreadsheet of your
names/addresses already created. Save it as a .csv
file. When you have opened your label file, click on
the Merge Properties tool. You will be asked what
kind of file you have: choose Comma Separated
Values (CSV) with keys on line 1 (that means your
spreadsheet columns have the names of each
column on the first line). I was also doing labels for
boxes of educational resources we were gifting, so
mine says Teacher Name, School, Town and
Number of Students on line 1 with the information
below. After you choose that, the next line will
enable you to specify your spreadsheet and file
location.

What I really like about this screen is that you don’t
have to make labels for every name if you don’t want
to (if you send Christmas cards, do you send to
every single person in your address book?) All you
have to do is uncheck the ones you don’t want to

Using gLabels: An Update
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use. I expanded the first line so you could see that
the headings are there. If I wanted to leave someone
out, I would just clear the checkbox at the left. I
don’t, so everyone is selected.

Click OK, go back to your label and add a new text
box. Now, in your Text tab, the Add Merge Field
Button will be activated. Choose your fields, then
add and arrange them.

To see your merge, simply press Print, then look at
the Print Preview. If it looks the way it should, you
can print your labels from there.

I usually close my print preview and go one step
further, exporting my labels as a PDF. I’ve had
trouble in the past with my printer pulling through 2
pages unevenly, and ruining both pages. If I can go
back to a PDF, I can print only those pages which
were ruined. Also, if I make it at home and print it at
work, which I do sometimes, the PDF is really

convenient because I don’t have gLabels on my
work computer (unfortunately). Some labels can be
printed again many times, like return address labels.
If I have it saved as a PDF, the spacing is perfect
and I can print it as many times as I want.

gLabels just works. Every time. Easily. I love it!

Screenshot ShowcaseScreenshot Showcase

Posted by Meemaw, on April 3, 2021 , running Xfce.

Using gLabels: An Update
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by CgBoy

LosslessCut is a simple, yet powerful video
trimming and splitting tool designed to be very fast
and easy to use. As the name implies, LosslessCut
manages to retain the original quality of the video
you are editing by directly cutting and copying over
the data stream, rather than actually re-encoding the
whole video. This also means that LosslessCut can
export videos much faster than a traditional video
editor can.

LosslessCut has a very polished and well designed
user interface. Loading in a video is as simple as
dragging and dropping it into the program.
LosslessCut can import from a variety of video
formats, such as MP4, MOV, MKV, and more. Any
videos not directly supported by LosslessCut can
easily be converted for editing by clicking on Convert
to supported format in the File menu (This is just for
preview and editing purposes only; the final video
will still be exported in the original format without any
quality loss).

Once you’ve loaded in a video, you can begin the
editing process. In the lower half of the screen, you
will find the timeline and time counter, play button
and keyframe seeker buttons, and the Cut Start and
Cut End buttons (The small hand pointer icons). The
cut start and end buttons allow you to set the
beginning and end points of each video segment. To
edit videos in LosslessCut, you essentially need to
select which segments of the video you want to
keep, and all the remaining bits of unselected video
will be removed. By default, there is one long
segment spanning the entire length of the video.

To remove a small section from the middle of a
video, for example, you could navigate to where the
section you wish to delete starts, click on the Cut
End button to set the endpoint of the first segment,
then navigate to where the removed section of video
ends and click on the + button in the segment list to
create a new segment (This new segment will
stretch until the end of the video). Each video
segment will appear in a list on the right side of the
screen, where you can add, remove, and change the

order of them. They will then be played in this order
when the video is exported.

Clicking on the Tracks button in the upper left corner
allows you to easily manage the video and audio
tracks. Here, you can enable and disable specific
tracks, extract and export each audio and video
track separately, and import new tracks, such as a
music track. Another useful feature LosslessCut has
is the ability to merge multiple videos into one video
file. This can be done by clicking on Merge files from
the Tools menu, and then selecting the videos that
you want to merge.

At the top of the window, you can click on Working
dir unset to set the location where LosslessCut will
save output files (It is set to the source folder by
default). LosslessCut automatically saves a CSV
project file to the output folder as you work on a
video. If you wish to change the output format of the
video, you can do so from the dropdown menu near
the top right corner. You can also choose whether to
export the segments each as separate files, or

Repo Review: LosslessCut
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merge them all into one video. Once you’re finished
editing the video, click Export and you’ll be
presented with an overview of the output options.
Here you can change the filename of the saved
video file if you wish to do so. As I mentioned earlier,
LosslessCut will export videos very quickly, usually
within a few seconds or so.

Summary

Overall, I’d say LosslessCut worked very well during
my testing. I did, however, occasionally encounter a
few problems when trying to export a video, but for
the most part, the program seemed quite stable.
LosslessCut’s speed and ease of use makes it an
excellent tool for any simple video cutting and
splitting tasks.

Screenshot ShowcaseScreenshot Showcase

The PCLinuxOS
Magazine

Created with
Scribus

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

Posted by mutse, on April 4, 2021 , running Mate.
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INGREDIENTS:

1/2 tablespoon olive oil
1/2 medium onion chopped
2 sticks celery chopped
1 pound extra lean (95% lean) ground beef
3 cloves garlic minced
2 heaping tablespoons tomato paste
1 (28 fluid ounce) can diced tomatoes with juices
4 cups beef broth
2 large Russet potatoes diced
1 dash Italian seasoning
Salt & pepper to taste

DIRECTIONS:

1. Add the olive oil, onion, and celery to your Instant
Pot. Press the sauté button and cook for 4 minutes.

2. Stir in the beef and garlic. Cook until the beef has
browned, stirring occasionally (about 5 minutes).
You shouldn't need to drain much fat if you're using
extra lean ground beef, but feel free to drain
some/most of it if desired.

3. Stir in the tomato paste, then add in the diced
tomatoes, beef broth, potatoes, and Italian
seasoning.

4. Close the lid, make sure the valve is on "sealing",
press the "manual" button and cook on high
pressure for 8 minutes.

5. Once the countdown has finished, carefully do a
quick pressure release.

6. Season with salt & pepper as needed and serve
immediately.

OPTIONS:

Substitute 1/4 cup Pearl Barley for potatoes for a
more high fiber hardy soup. Increase cooking time to
20 minutes.

Replaced diced potatoes with 1/2 cup macaroni
(elbow) and add 1/2 cup additional beef broth and
reduce cooking time to 4 minutes

NUTRITION:

Carbs: 30g Calories: 253
Fiber: 3g Sodium: 854mg

To help reduce sodium use low sodium beef broth in
the recipe.

PCLinuxOS Recipe Corner

Instant Pot Hamburger Soup

http://www.linuxfoundation.org/
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by Meemaw

Sometimes you are working with a photo and think it
would be better if the background was different, or
just gone. I found a tutorial that outlined several
ways to remove the background from an image.
Let’s look at a couple of methods.

Fuzzy Select

One of the methods you may already know is using
the Fuzzy Select tool. It’s used best when the
background is fairly different from the part you want
to keep. I used the Fuzzy Select tool on this photo in
order to put a different sky in.

This is a really pretty photo, but suppose you want to
add a sky that indicates a later time? You can take
out the present background fairly easily (without
having to erase everything by hand).

Load your photo into GIMP, and in the layers dialog,
right-click on the layer and check the box in front of

Add Alpha channel. If that menu item is greyed out,
your photo already has one.

The Alpha channel allows transparency to be
present in your image. If we’re taking out the
background, it will have to be replaced with
transparency.

Now choose your Fuzzy Select tool. (It looks like a
magic wand.) In my photo, I clicked on the blue area
first. You should check the antialiasing box and the
feather edges box (and set the feathering to maybe
0 - 5), and then can change the threshold up and
down until much of your blue is selected. In the
image below, my threshold setting was 82, but every
image is different (top, right).

Pressing the Delete key, I get the following (right):

Click on Select > None to clear your selection. Now
go back and choose the orange cloud part, and
delete it, too. If you have separate places that both
need to be deleted (like the orange on either side of
the people, hold down Shift and click your other
area.

Notice in this photo that there is sky showing
between the people’s legs that needs to be removed
as well. I did this separately by zooming in to make
sure I had everything.

GIMP Tutorial: Remove A Background
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It may be necessary to use your eraser as well, but
by now, you won’t have much to erase. I added a
white layer so I could see what still needed to be
removed. I’d rather erase that little bit rather than the
whole background.

Then, I proceeded to add a different background.
I added a layer and filled it with a gradient.

Paths Tool

Some things are a bit easier. I want to cut out all the
audience watching this cutie do a backbend, but
leave the cutie and the mat.

Choosing the paths tool, I can draw around the part I
want. The paths tool allows me to curve those lines
that need to be curved.

When you get around to the beginning again, and
click in your first point, hit the Enter key to finish your
path. Now, choose Select > Invert to change your
selection to the background rather than the path you
just drew. Then hit Delete. To get rid of the path,
choose Select > None(top, right).

I then added a new layer and put a rather plain
background in, but you could put anything in you
want (right).

Next time we do GIMP, I’ll describe a couple more
ways to erase a background easily.

GIMP Tutorial: Remove A Background
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by Bennett Cyphers
Electronic Frontier Foundation
Reprinted under Creative Commons 3.0 Attribution License

Cookies are dying, and the tracking industry is scrambling to replace them.
Google has proposed Federated Learning of Cohorts (FLoC), TURTLEDOVE,
and other bird-themed tech that would have browsers do some of the behavioral
profiling that third-party trackers do today. But a coalition of independent
surveillance advertisers has a different plan. Instead of stuffing more tracking
tech into the browser (which they don’t control), they’d like to use more stable
identifiers, like email addresses, to identify and track users across their devices.

There are several proposals from ad tech providers to preserve “addressable
media” (read: individualized surveillance advertising) after cookies die off. We’ll
focus on just one: Unified Identifier 2.0, or UID2 for short, developed by
independent ad tech company The Trade Desk. UID2 is a successor to The
Trade Desk’s cookie-based “unified ID.” Much like FLoC, UID2 is not a drop-in
replacement for cookies, but aims to replace some of their functionality. It won’t
replicate all of the privacy problems of third-party cookies, but it will create new
ones.

There are key differences between UID2 and Google’s proposals. FLoC will not
allow third-party trackers to identify specific people on its own. There are still big
problems with FLoC: it continues to enable auxiliary harms of targeted ads, like

discrimination, and it bolsters other methods of tracking, like fingerprinting. But
FLoC’s designers intend to move towards a world with less individualized third-
party tracking. FLoC is a misguided effort with some laudable goals.

In contrast, UID2 is supposed to make it easier for trackers to identify people. It
doubles down on the track-profile-target business model. If UID2 succeeds,
faceless ad tech companies and data brokers will still track you around the
web—and they’ll have an easier time tying your web browsing to your activity on
other devices. UID2’s proponents want advertisers to have access to long-term
behavioral profiles that capture nearly everything you do on any Internet-
connected device, and they want to make it easier for trackers to share your data
with each other. Despite its designers’ ill-taken claims around “privacy” and
“transparency,” UID2 is a step backward for user privacy.

How Does UID2 Work?

In a nutshell, UID2 is a series of protocols for collecting, processing, and passing
around users’ personally-identifying information (“PII”). Unlike cookies or FLoC,
UID2 doesn’t aim to change how browsers work; rather, its designers want to
standardize how advertisers share information. The UID2 authors have published
a draft technical standard on Github. Information moves through the system like
this:

1. A publisher (like a website or app) asks a user for their personally-identifying
information (PII), like an email address or a phone number.

2. The publisher shares that PII with a UID2 “operator” (an ad tech firm).

3. The operator hashes the PII to generate a “Unified Identifier” (the UID2). This
is the number that identifies the user in the system.

4. A centralized administrator (perhaps The Trade Desk itself) distributes
encryption keys to the operator, who encrypts the UID2 to generate a “token.”
The operator sends this encrypted token back to the publisher.

5. The publisher shares the token with advertisers.

6. Advertisers who receive the token can freely share it throughout the advertising
supply chain.

After Cookies, Ad Tech Wants To Use
Your Email To Track You Everywhere
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7. Any ad tech firm who is a “compliant member” of the ecosystem can receive
decryption keys from the administrator. These firms can decrypt the token into a
raw identifier (a UID2).

8. The UID2 serves as the basis for a user profile, and allows trackers to link
different pieces of data about a person together. Raw UID2s can be shared with
data brokers and other actors within the system to facilitate the merging of user
data.

The description of the system raises several questions. For example:

* Who will act as an “administrator” in the system? Will there be one or many,
and how will this impact competition on the Internet?

* Who will act as an “operator?” Outside of operators, who will the “members” of
the system be? What responsibilities towards user data will these actors have?

* Who will have access to raw UID2 identifiers? The draft specification implies
that publishers will only see encrypted tokens, but most advertisers and data
brokers will see raw, stable identifiers.

What we do know is that a new identifier, the UID2, will be generated from your
email. This UID2 will be shared among advertisers and data brokers, and it will
anchor their behavioral profiles about you. And your UID2 will be the same across
all your devices.

How Does UID2 Compare With Cookies?

Cookies are associated with a single browser. This makes it easy for trackers to
gather browsing history. But they still need to link cookie IDs to other
information—often by working with a third-party data broker—in order to connect
that browsing history to activity on phones, TVs, or in the real world.

UID2s will be connected to people, not devices. That means an advertiser who
collects UID2 from a website can link it to the UID2s it collects through apps,
connected TVs, and connected vehicles belonging to the same person. That’s
where the “unified” part of UID2 comes in: it’s supposed to make cross-device
tracking as easy as cross-site tracking used to be.

UID2 is not a drop-in replacement for cookies. One of the most dangerous
features of cookies is that they allow trackers to stalk users “anonymously.” A
tracker can set a cookie in your browser the first time you open a new window; it
can then use that cookie to start profiling your behavior before it knows who you
are. This “anonymous” profile can then be used to target ads on its own (“we

don’t know who this person is, but we know how they behave”) or it can be stored
and joined with personally-identifying information later on.

In contrast, the UID2 system will not be able to function without some kind of
input from the user. In some ways, this is good: it means if you refuse to share
your personal information on the Web, you can’t be profiled with UID2. But this
will also create new incentives for sites, apps, and connected devices to ask
users for their email addresses. The UID2 documents indicate that this is part of
the plan:

Addressable advertising enables publishers and developers to provide the content and
services consumers have come to enjoy, whether through mobile apps, streaming TV, or
web experiences. … [UID2] empowers content creators to have the value exchange
conversations with consumers while giving them more control and transparency over
their data.

The standard authors take for granted that “addressable advertising” (and
tracking and profiling) is necessary to keep publishers in business (it’s not). They
also make it clear that under the UID2 framework, publishers are expected to
demand PII in exchange for content.

How UID2 will work on websites, according to the documentation.

This creates bad new incentives for publishers. Some sites already require log-
ins to view content. If UID2 takes off, expect many more ad-driven websites to
ask for your email before letting you in. With UID2, advertisers are signaling that
publishers will need to acquire, and share, users’ PII before they can serve the
most lucrative ads.

Where Does Google Fit In?

In March, Google announced that it “will not build alternate identifiers to track
individuals as they browse across the web, nor... use them in [its] products.”
Google has clarified that it won’t join the UID2 coalition, and won’t support similar
efforts to enable third-party web tracking. This is good news—it presumably
means that advertisers won’t be able to target users with UID2 in Google’s ad

After Cookies, Ad Tech Wants To Use Your Email To Track You Everywhere
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products, the most popular in the world. But UID2
could succeed despite Google’s opposition.

Unified ID 2.0 is designed to work without the
browser’s help. It relies on users sharing personal
information, like email addresses, with the sites they
visit, and then uses that information as the basis for
a cross-context identifier. Even if Chrome, Firefox,
Safari, and other browsers want to rein in cross-site
tracking, they will have a hard time preventing
websites from asking for a user’s email address.

Google’s commitment to eschew third-party
identifiers doesn’t mean said identifiers are going
away. And it doesn’t justify creating new targeting
tech like FLoC. Google may try to present these
technologies as alternatives, and force us to choose:
see, FLoC doesn’t look so bad when compared with
Unified ID 2.0. But this is a false dichotomy. It’s more
likely that, if Google chooses to deploy FLoC, it will
complement—not replace—a new generation of
identifiers like UID2.

UID2 focuses on identity, while FLoC and other
“privacy sandbox” proposals from Google focus on
revealing trends in your behavior. UID2 will help
trackers capture detailed information about your
activity on the apps and websites to which you
reveal your identity. FLoC will summarize how you
interact with the rest of the sites on the web.
Deployed together, they could be a potent
surveillance cocktail: specific, cross-context
identifiers connected to comprehensive behavioral
labels.

What Happens Next?

UID2 is not a revolutionary technology. It’s another
step in the direction that the industry has been
headed for some time. Using real-world identifiers
has always been more convenient for trackers than
using pseudonymous cookies. Ever since the
introduction of the smartphone, advertisers have
wanted to link your activity on the Web to what you

do on your other devices. Over the years, a cottage
industry has developed among data brokers, selling
web-based tracking services that link cookie IDs to
mobile ad identifiers and real-world info.

The UID2 proposal is the culmination of that trend.
UID2 is more of a policy change than a technical
one: the ad industry is moving away from the
anonymous profiling that cookies enabled, and is
planning to demand email addresses and other PII
instead.

The demise of cookies is good. But if tracking tech
based on real-world identity replaces them, it will be
a step backward for users in important ways. First, it
will make it harder for users in dangerous
situations—for whom web activity could be held
against them—to access content safely. Browsing
the web anonymously may become more difficult or
outright impossible. UID2 and its ilk will likely make it
easier for law enforcement, intelligence agencies,
militaries, and private actors to buy or demand
sensitive data about real people.

Second, UID2 will incentivize ad-driven websites to
erect “trackerwalls,” refusing entry to users who’d
prefer not to share their personal information.
Though its designers tout “consent” as a guiding
principle, UID2 is more likely to force users to hand
over sensitive data in exchange for content. For
many, this will not be a choice at all. UID2 could
normalize “pay-for-privacy,” widening the gap
between those who are forced to give up their
privacy for first-class access to the Internet, and
those who can afford not to.
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by Michael Barclay
Electronic Frontier Foundation
Reprinted under Creative Commons 3.0 Attribution
License

In a win for innovation, the U.S. Supreme Court has
held that Google’s use of certain Java Application
Programming Interfaces (APIs) is a lawful fair use. In
doing so, the Court reversed the previous rulings by
the Federal Circuit and recognized that copyright
only promotes innovation and creativity when it
provides breathing room for those who are building
on what has come before.

This decision gives more legal certainty to software
developers’ common practice of using, re-using, and
re-implementing software interfaces written by
others, a custom that underlies most of the internet
and personal computing technologies we use every
day.

To briefly summarize over ten years of litigation:
Oracle claims a copyright on the Java
APIs—essentially names and formats for calling
computer functions—and claims that Google
infringed that copyright by using (reimplementing)
certain Java APIs in the Android OS. When it
created Android, Google wrote its own set of basic
functions similar to Java (its own implementing

code). But in order to allow developers to write their
own programs for Android, Google used certain
specifications of the Java APIs (sometimes called
the “declaring code”).

APIs provide a common language that lets programs
talk to each other. They also let programmers
operate with a familiar interface, even on a
competitive platform. It would strike at the heart of
innovation and collaboration to declare them
copyrightable.

EFF filed numerous amicus briefs in this case
explaining why the APIs should not be copyrightable
and why, in any event, it is not infringement to use
them in the way Google did. As we’ve explained
before, the two Federal Circuit opinions are a
disaster for innovation in computer software. Its first
decision—that APIs are entitled to copyright
protection—ran contrary to the views of most other
courts and the long-held expectations of computer
scientists. Indeed, excluding APIs from copyright
protection was essential to the development of
modern computers and the internet.

Then the second decision made things worse. The
Federal Circuit's first opinion had at least held that a
jury should decide whether Google’s use of the Java
APIs was fair, and in fact a jury did just that. But
Oracle appealed again, and in 2018 the same three
Federal Circuit judges reversed the jury's verdict and
held that Google had not engaged in fair use as a
matter of law.

Fortunately, the Supreme Court agreed to review the
case. In a 6-2 decision, Justice Breyer explained
why Google’s use of the Java APIs was a fair use as
a matter of law. First, the Court discussed some
basic principles of the fair use doctrine, writing that
fair use “permits courts to avoid rigid application of

the copyright statute when, on occasion, it would
stifle the very creativity which that law is designed to
foster.”

Furthermore, the court stated:

Fair use “can play an important role in determining the
lawful scope of a computer program copyright . . . It can
help to distinguish among technologies. It can distinguish
between expressive and functional features of computer
code where those features are mixed. It can focus on the
legitimate need to provide incentives to produce
copyrighted material while examining the extent to which
yet further protection creates unrelated or illegitimate
harms in other markets or to the development of other
products.”

In doing so, the decision underlined the real purpose
of copyright: to incentivize innovation and creativity.
When copyright does the opposite, fair use provides
an important safety valve.

Justice Breyer then turned to the specific fair use
statutory factors. Appropriately for a functional
software copyright case, he first discussed the
nature of the copyrighted work. The Java APIs are a
“user interface” that allow users (here the
developers of Android applications) to “manipulate
and control” task-performing computer programs.
The Court observed that the declaring code of the
Java APIs differs from other kinds of copyrightable
computer code—it’s “inextricably bound together”
with uncopyrightable features, such as a system of
computer tasks and their organization and the use of
specific programming commands (the Java “method
calls”). As the Court noted:

Unlike many other programs, its value in significant part
derives from the value that those who do not hold
copyrights, namely, computer programmers, invest of
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their own time and effort to learn the API’s system. And
unlike many other programs, its value lies in its efforts to
encourage programmers to learn and to use that system
so that they will use (and continue to use) Sun-related
implementing programs that Google did not copy.

Thus, since the declaring code is “further than are
most computer programs (such as the implementing
code) from the core of copyright,” this factor favored
fair use.

Justice Breyer then discussed the purpose and
character of the use. Here, the opinion shed some
important light on when a use is “transformative” in
the context of functional aspects of computer
software, creating something new rather than simply
taking the place of the original. Although Google
copied parts of the Java API “precisely,” Google did
so to create products fulfilling new purposes and to
offer programmers “a highly creative and innovative
tool” for smartphone development. Such use “was
consistent with that creative ‘progress’ that is the
basic constitutional objective of copyright itself.”

The Court discussed “the numerous ways in which
reimplementing an interface can further the
development of computer programs,” such as
allowing different programs to speak to each other
and letting programmers continue to use their
acquired skills. The jury also heard that reuse of
APIs is common industry practice. Thus, the opinion
concluded that the “purpose and character” of
Google’s copying was transformative, so the first
factor favored fair use.

Next, the Court considered the third fair use factor,
the amount and substantiality of the portion used. As
a factual matter in this case, the 11,500 lines of
declaring code that Google used were less than one
percent of the total Java SE program. And even the
declaring code that Google used was to permit
programmers to utilize their knowledge and
experience working with the Java APIs to write new
programs for Android smartphones. Since the
amount of copying was “tethered” to a valid and

transformative purpose, the “substantiality” factor
favored fair use.

Finally, several reasons led Justice Breyer to
conclude that the fourth factor, market effects,
favored Google. Independent of Android’s
introduction in the marketplace, Sun didn’t have the
ability to build a viable smartphone. And any sources
of Sun’s lost revenue were a result of the investment
by third parties (programmers) in learning and using
Java. Thus, “given programmers’ investment in
learning the Sun Java API, to allow enforcement of
Oracle’s copyright here would risk harm to the
public. Given the costs and difficulties of producing
alternative APIs with similar appeal to programmers,
allowing enforcement here would make of the Sun
Java API’s declaring code a lock limiting the future
creativity of new programs.” This “lock” would
interfere with copyright’s basic objectives.

The Court concluded that “where Google
reimplemented a user interface, taking only what
was needed to allow users to put their accrued
talents to work in a new and transformative program,
Google’s copying of the Sun Java API was a fair use
of that material as a matter of law.”

The Supreme Court left for another day the issue of
whether functional aspects of computer software are
copyrightable in the first place. Nevertheless, we are
pleased that the Court recognized the overall
importance of fair use in software cases, and the
public interest in allowing programmers, developers,
and other users to continue to use their acquired
knowledge and experience with software interfaces
in subsequent platforms.
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by Ramchu

When the Covid Pandemic hit, there was a rush to
purchase webcams. The prices skyrocketed and
many people were unable to purchase one, either
due to short supplies or being priced out of the
market.

Now I may be a little late to the party, but I have
found a way to have a webcam that won't break the
bank, and won't play havoc on your nervous system
trying to get it setup.

Enter “IP Webcam,” developed by Pavel Khlebovich.

IP Webcam is an Android app that is freely available
in the Google Play Store.

The Prerequisites

1 - A computer and a smartphone that are connected
to the same network.

2 - A wireless router.

3 - A web browser.

4 - The IP Webcam app

Open up the Google Play Store app and search for
IP Webcam. Download and install it onto the
smartphone.

Once the App is installed, open it and you will be
presented with this screen on the phone.

On the left is what you will initially see. As you scroll
down the screen, the image on the right will become
visible.

Scroll down and select Start server (leave all other
settings as they are for now).

Almost immediately you will see on the screen a
projection of what the phone's camera is seeing (top,
right).

Notice that at the bottom of the screen are some IP
addresses. Make note of them. You will be using
them in the next step.

Now on your computer, open a web browser (I used
Firefox).

In the web browser, enter the IP Address (I used the
http:// version) that was shown on your phone's
screen. It should look something like
http://192.168.6.123:8080.

Now you will be presented with the IP Webcam
control page in your browser.

Use Your Phone Camera As A Webcam
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In this page near the top you will see “Video
renderer.” Select “browser” from the choices.

You will also see “Audio player” as a selection. Here,
I selected “HTML5 Wav,” and it did give me audio,
but the latency was terrible.

There you have an economical and easy way to
have a wireless webcam.

If you decide to continue to use this setup, you can
adjust the settings to whatever works best for your
situation, complete with password protection.

On a side note I was also able to get this working in
VLC Media Player and SM Player.
The IP address is a bit different in these players, as
it will be (as an example)
http://192.168.5.123:8080/video.

In VLC click on Media > Open Network Stream, and
then the IP address.

In SM Player click Open > URL, and then the IP
address.

Screenshot ShowcaseScreenshot Showcase

Posted by parnote, on April 15, 2021 , running Xfce.
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INGREDIENTS:

8oz uncooked campanelle or rotini
or bow-tie pasta (2 3/4 cups)

24 frozen cooked Italian-style meatballs
(from 22-oz bag)

1 jar (25.5 oz) Organic tomato basil pasta sauce
2 cups water
1/2 teaspoon Italian seasoning
1 1/2 cups shredded mozzarella cheese (6 oz)
Chopped fresh basil leaves, if desired

DIRECTIONS:

1. Heat oven to 375F (190C). Spray a 13x9-inch
glass baking dish with cooking spray.

2. In a large bowl, mix pasta, frozen meatballs,
pasta sauce, water and Italian seasoning. Pour
mixture into dish. Cover tightly with foil. Bake for 40-
50 minutes. Remove the dish from the oven; stir
mixture thoroughly. Sprinkle it with cheese.

3. Bake uncovered 5 to 8 minutes longer or until
pasta is tender and cheese is melted. Garnish with
basil leaves before serving.

TIPS:

Shredded Italian cheese blend may be substituted
for shredded mozzarella cheese.

Stir in 1/4 to 1/2 teaspoon crushed red pepper flakes
to add a subtle spicy heat to this pasta.

NUTRITION:

Calories: 500
Carbs: 47
Fiber: 5g
Sodium: 840mg

The PCLinuxOS
Magazine

Created with
Scribus

PCLinuxOS Recipe Corner Bonus

Dump-and-Go Meatball Lasagna
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D

o
w
n
lo
a
d
P
u
z
z
le
S
o
lu
ti
o
n
s
H
e
re

Possible score 273, average score 191.

PCLinuxOS Puzzled Partitions
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AFFECTION APPRECIATION

BOUQUET BREAKFAST IN BED

CARD CARNATIONS

CELEBRATION CHERISH

CHILDREN CHOCOLATE

DAUGHTER DEDICATION

ENDEARING FAMILY

FLOWERS GRANDMOTHER

GRATITUDE HEART

HERITAGE HOLIDAY

HONOR JEWELRY

KISS LOVE

MATERNAL MAY

MOTHERHOOD PARENT

PERFUME QUALITY

REMEMBER ROSES

SON SUNDAY

SWEETHEART THANKS

THOUGHTFUL TULIPS

UPBRINGING WISDOM
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1. Something that is passed down from preceding
generations; a tradition.

2. Having or showing concern for the well-being
of others.

3. Inspiring affection or warm sympathy.
4. The act of performing or observing with

appropriate rites or ceremonies to honor a
person or event.

5. A day free from work that one may spend at
leisure.

6. Recognition of the quality, value, significance,
or magnitude of people and things.

7. The willingness to give a lot of time and energy
to something because it is important.

8. A tender feeling toward another; fondness.
9. An inherent or distinguishing characteristic;

a property.
10. The qualities of a mother.
11. The rearing and training received during

childhood.
12. To love, protect, and care for someone or

something that is important to you
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Posted by seaplanetux, on March 31 , 2021 , running KDE.

Posted by tuxlink, on April 1 , 2021 , running KDE.

Posted by tbschommer, on March 31 , 2021 , running KDE.

Posted by yankee, on April 1 , 2021 , running Mate.
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